Garden Studio
Reference
Table of Contents
GARDEN STUDIO................................................................................................ 2
MENUS................................................................................................................. 4
File ...................................................................................................................... 4
List....................................................................................................................... 5
Templates............................................................................................................ 6
Help ..................................................................................................................... 7

WORKING WITH GARDEN STUDIO ................................................................... 8
Creating and Editing Plant Lists ........................................................................... 8
Entering Data Into the Lists................................................................................ 10
Forms ................................................................................................................ 11
Organizing Templates........................................................................................ 12

FORMS WINDOW .............................................................................................. 14

1

Garden Studio
This is the Garden Studio window.

At the right side of the window, you can see the list of templates (see Organizing
Templates). At the top of the window you can see the menus and the Standard
toolbar. When you import plants into Garden Studio, they show up in the list at
the left side of the window. You can see that there are four plants there in the
picture above.
To import plants to Garden Studio, select the plants from the Garden Workbench
plant list that you wish to import and select the Garden Studio command on the
Window menu (for more about working with plant lists, see Creating and Editing
Plant Lists). When you import plants to Garden Studio, you will notice that they
appear in the window with the counts all set to 1.
If at some time you wish to add more plants to the Garden Studio plant list, you
can go back to the workbench (without closing the Garden Studio window), select
more plants to add and then once again execute the Garden Studio command
found on the Window menu.
You will notice in the picture above that there are fields named Price, Barcode,
My data, etc. These are the fields that you can find in the Garden Studio tab for
each plant. You can edit the fields here and it is the same as editing the value in
the Garden Studio tab. To edit the field, click in the field and enter the data.
NOTE: If you have 50 or less plants in the Workbench plant list and no plant is
selected at the time that you execute the Garden Studio command, it will export
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all of the plants in the list to Garden Studio.
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Menus
File
The following is a list of all the commands found on the File drop-down menu.
Some of these commands can be found on the Standard toolbar as well.

Open List
You can use the Open List command to open a previously saved Garden Studio
list. When you open a saved list, it will also open the values that were in the fields
at the time of the save.

Save List
You can use the Save List command to save previously saved lists. When you
choose this command, it will save over the previous save and replace it with the
new list under the same file name.
NOTE: If you choose this command before you have saved your work, it will
execute the Save List As command and prompt you to name the saved file.

Save List As
You can also use the Save List As command to save a list. When you choose
this command, it will prompt you to choose a file name under which to save and it
will save the list as totally independent from any previous saves.

Print
You can use the Print command to print your work.

Print Preview
You can use the Print Preview to see a preview of what your work will look after
it is printed.

Exit
You can use the Exit command to exit the Garden Studio module.
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List
The following is a list of all the commands found on the List drop-down menu.
Some of these commands can be found on the Standard toolbar as well.

Clear List
You can use the Clear List command to clear all entries from the Template
Designer.

Append Selected
When you have a list of plants in the Template Designer and you wish to add
more, you can do so with the Append Selected command. With a list open, go
back to the Garden Workbench. At the Garden Workbench, select the plants
that you wish to add. Then go back to the Garden Studio module and choose the
Append Selected command. It will then add the selected plants to the list.

Insert Static
You can use the Insert Static command to insert a static entry into the plant list.
This entry is practical for creating signs that have nothing to do with any specific
plant.

Reset Counts
You can use the Reset Counts command to reset the counts of all of your
entries to zero.

Set Counts
You can use the Set Counts command to set all of the counts of your entries to
the same specific number.

Delete Entry
You can use the Delete Entry command to delete selected entries.

Undo List Change
You can use the Undo List Change to undo the last change that you made to
the list.

List Print Preview
You can use the List Print Preview command to see a preview of how your
plant list would look if printed. There is also an option to print the plant list from
this page. In the preview, only the first three data columns show and will print
when you select the print command.
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Templates
The following is a list of all the commands found on the Templates drop-down
menu. Some of these commands can be found on the Standard toolbar as well.

Open
You can use the Open command to open selected templates. From this window
you can modify template settings such as field placement and field data.
You can also open a template by double-clicking on it.

New Folder
You can use the New Folder command to create a new folder in the templates
window which you can use to organize your templates.

New Template
You can use the New Template command to create a new template.

Duplicate Template
You can use the Duplicate Template command to make a duplicate of selected
templates.

Rename
You can use the Rename command to rename selected folders or templates.

Delete
You can use the Delete command to delete selected folders or templates.

Assign Form
You can use the Assign Form command to assign forms to selected templates.
When you use this command, you will be asked to choose one of Horticopia's
pre-existing forms.
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Help
The following is a list of all the commands found on the Help drop-down menu.
Some of these commands can be found on the Standard toolbar as well.

Garden Studio Help
The Garden Studio Help command opens the Garden Studio help program.

http://horticopia.com/
This command takes you to the Horticopia website if you are connected to the
Internet.

About Garden Studio
The About Garden Studio command opens a window that gives you some brief
information on Garden Studio.
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Working with Garden Studio
Creating and Editing Plant Lists
The following topics are discussed in this section.
1. Transferring a List from the Workbench
2. Saving Lists
3. Appending to an Existing List
4. Deleting Items

Transferring a List from the Workbench
When you are at the Garden Workbench, it is very simple to transfer a list into
the Template Designer. All that you must do is select the plants that you would
like to add and select the Garden Studio command from the Window drop-down
menu. This will then open the Template Designer with all the selected plants
already in the plant list.
NOTE: To select multiple plants, hold down the CTRL key while clicking on them.
NOTE: If you have 50 or less plants in the Garden Workbench plant list and have
no plant selected at the time when you execute the Garden Studio command, the
program will export all of the plants to the Garden Studio window.

Saving Lists
When you have a list of plants that you wish to access frequently or that you
simply wish to save, you may do so by using the Save List and Save List As
commands. Both of these commands can be found under the File drop-down
menu.
You can use the Save List As command to save a new list or simply to save a
list under a different file name. When you choose this command, it will prompt
you to choose a file name under which to save and it will save the list as totally
independent from any previous saves.
You can use the Save List command to save previously saved lists. When you
choose this command, it will save over the previous save and replace it with the
new list under the same file name.
The Save List button
can be found on the Standard toolbar.
NOTE: If you choose this command before you have saved your work, it will
execute the Save List As command and prompt you to name the saved file.

Appending to an Existing List
When you have a list of plants in the Template Designer and you wish to add
more, you can do so with the Append Selected command. With a list open, go
back to the Garden Workbench. At the Garden Workbench, select the plants
that you wish to add. Then go back to the Garden Studio module and choose the
Append Selected command. It will then add the selected plants to the list. The
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Append Selected command can be found on the List drop-down menu and the
Append Selected button

can be found on the Standard toolbar.

Deleting Items
If you wish to delete an entry that you have made to your plant list, you may do
so by using the Delete command. Select the entry which you would like to delete
and then select the Delete Entry command found in the List drop-down menu.
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Entering Data Into the Lists
The following topics are discussed in this section.
1. Setting the Count Values
2. Entering Values for the Garden Studio Tab's Data Fields
3. Static Entries

Setting the Count Values
You can set the count values for the entries in your plant list several ways. You
can enter them manually by clicking in the count box and typing in the values that
you wish for each plant.
You can also set all the count values to the same value by selecting the Set
Counts option found in the List drop-down menu. It will then prompt you to
choose a value and will set all the count values to the chosen number.
There is also a command that sets all the count values of the plants in your list to
zero. Select the Reset Counts command which can be found in the List dropdown menu to do this.
The Set Counts button
the Standard toolbar.

and the Reset Counts button

can be found on

Entering Values for the Garden Studio Tab's Data Fields
When you create fields in a template, some of them draw from the Garden Studio
tab's. You can change the data that is entered into these fields for each individual
plant. From the Garden Workbench you can select a plant for which you would
like to modify the data and change the field values in the Garden Studio Tab.
You can also use the fields given in the plant list to modify several of the data
fields found in the Garden Studio Tab. You can simply click in the data field you
wish to modify and type in the information that you wish to insert.

Static Entries
In the Template Designer, there is also the option of adding static entries to the
plant list. These entries are meant to be used to create signs that do not have
anything to do with any specific plant or plant data and Static Entries do not
really have any practical use in being added in with a collection of other plants.
They are useful in creating signs for things such as hard goods.
The Insert Static Entry button
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can be found on the Standard toolbar.

Forms
The following topics are discussed in this section.
1. Assigning a Form to a Template
2. Changing Form Assignment
3. Forms and Printers

Assigning a Form to a Template
To assign a form to a template you must simply select the template on which you
would like to change the form and then select the Assign Form command that
can be found in the Templates drop-down menu. It will then take you to the
Assign Forms window and ask you to select a form for the template.
The Assign Form button

can be found on the Standard toolbar.

Changing Form Assignment
To change the form assignment of a template, you must simply select the
template to which you would like to make changes and either select the Assign
Form command which can be found in the Templates drop-down menu or use
on the Standard toolbar. Then this takes you to the
the Assign Form button
Assign Forms window and you simply make the appropriate changes.

Forms and Printers
When examining the forms available in Garden Studio, you will notice that some
of the appear to be the same but in reverse. For example you will find the forms
8.5 x 11 and 11 x 8.5. These, however, are not the same. When you select the
8.5 x 11 form, it will print out with the side measured as 8.5 inches being oriented
as the bottom of the page. This is also sometimes called portrait orientation.
When you select the 11 x 8.5 form, it will print out with the side measured as 11
inches being oriented as the bottom of the page.
In order to print out forms from Garden Studio, in addition to selecting the form,
your printer must recognize the form. In many cases, your printer should
recognize the forms but sometimes your printer may not recognize less standard
form specifications. This does not necessarily mean that you cannot print these
forms but that you must add these to the list of forms that your printer recognizes.
You will know that your printer does not recognize a certain form if when you
print you cannot find the specified form in the print dialog window.
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Organizing Templates
The following topics are discussed in this section.
1. Creating and Modifying Templates from the Folder Menu
2. Folders
3. Moving Templates and Folders
You can access some of the commands found below by right-clicking in the
folder window and selecting from the menu that pops up.

Creating and Modifying Templates from the Folder Window
When you wish to create a new template, you can do so by going under the
Templates drop-down menu and selecting New Template. You can also find the
New Template button
on the Standard toolbar. A new template will appear
in the templates window on the right side of the screen. If you then double-click
on the template, it will prompt you to choose a form to assign the template and
then take you to a screen from which you can edit the template.
You can also rename templates. You can select the template that you wish to
rename and select the Rename command in the Templates drop-down menu.
You can also find the Rename button
on the Standard toolbar. You then will
be able to type in the desired name for that template. You can also use this
command to rename folders.
Duplicating templates is also a possibility. If you have a template that you would
like to duplicate, simply select the template and choose the Duplicate Template
command found in the Templates drop-down menu. You can also find the
Duplicate Template button
in the Standard toolbar. After selecting this
command you will see a copy of the template appear below the chosen template.
If at some time you wish to delete a template, click on the template and select the
Delete command found in the Templates drop-down menu. You can also find
the Delete button on the Standard toolbar. You can also use this command to
delete folders.

Folders
In addition to creating new templates, you can create new folders used to
organize these templates. You can do this by going under the Templates dropdown menu and selecting New Folder. You can also find the New Folder button
in the Standard toolbar. A new folder will appear in the templates window on
the right side of the screen.
The folders that you have created are used to organize your templates. The
folder organization system works exactly like a regular filing cabinet. You can
insert template designs into folders or even folders into folders.

Moving Templates and Folders
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You can move around the templates and folders in your "filing system". To do
this, simply drag and drop the file or folder onto the folder in which you would like
it.
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Forms Window

This is the Assign Forms window. In this window you can browse through the
various form types and then select the appropriate one.
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